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Part 1. IBM Content Collector Version 4.0.1 Fix Pack 10 Readme 
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instructions, prerequisites and co-requisites, and information about fixes, changes, and limitations for IBM Content 

Collector for Email, IBM Content Collector for File Systems and IBM Content Collector for Microsoft SharePoint. 
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Download location 

Download IBM Content Collector, Version 4.0.1 Fix Pack 10, from the following location: 

http://www.ibm.com/support/docview.wss?uid=ibm10883002 

The following deliverables are available for download. 

 

Product / Component name File name  

 
Platform 

IBM Content Collector V4.0.1 FP010 

Readme 

 

4.0.1.10-IBM-ICC-FP010.pdf 

 

 (N/A) 

IBM Content Collector V4.0.1 FP010 Server 

 

4.0.1.10-IBM-ICC-Server-FP010.zip 

 

Windows 

 

http://www.ibm.com/support/docview.wss?uid=ibm10883002
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Prerequisites and co-requisites 

The server package of IBM Content Collector V4.0.1 Fix Pack 10 requires IBM Content Collector V4.0.1 installed on 

your operating system. 

For information about hardware and software compatibility, see the detailed system requirements document at 

http://www.ibm.com/support/docview.wss?uid=swg27042658. 

Known issues / Limitations 

 

IBM WebSphere Liberty Application Server Migration 

1. Support for IBM Content Collector Web Application services application programming interfaces (APIs) is not 

available in 4.0.1 Fix Pack 10. 

2. Web Application deployment on the External Web Application Server is not supported with this release. 

3. After upgrading to 4.0.1 Fix Pack 10, the IBM Content Collector Web Application IsAlive page may give a ‘500 

Error’ on the first launch. This may be due to longer time taken by deployment during Fix Pack installation, 

causing an incomplete extraction of AfuFolder. This can be resolved by uninstalling and reinstalling the IBM 

Content Collector Web Application. 

4. When launched through the IBM Notes client, the IBM Content Collector Search page may sometimes fail to 

load due to the SSL handshake communication error. To resolve this issue, follow the below steps for recreating 

the certificate: 

a. Delete key.p12 from 

 <<ICC installation directory >>\AFUWeb\wlp\usr\servers\AFUWeb\resources\security 

b. Navigate to AFUWeb directory and run afu_ewas_exchange_cert.bat. This step creates the certificate 

store used by Liberty. 

c. Restart the IBM Content Collector Liberty Web application. 

5. During the uninstallation of the ICC Web Application or during the Content Collector Repair, if additional 

certificates were added to the Liberty certificate keystore, perform the following steps because the types of 

certificates are different for eWAS and WebSphere Liberty: 

a. When uninstalling the Web application Liberty profile, take a back up liberty profile directory 

"..\AFUWeb\resources\security" 

b. When installation of web application Liberty profile is completed, restore back the certificate to  liberty 

profile directory "..\AFUWeb\resources\security" 

c. Reconfigure the web application service. 

 

Microsoft Windows Server 2019 Support 

1. The IBM Content Collector for Domino on Microsoft Windows Server 2019 operating system requires IBM 

Domino 9.0.1 FP10 (32-bit) installed on your operating system. The IBM Domino Server 9.0.1 (32-bit) base on 

Microsoft Windows Server 2019 may fail with security error logged in Application event logs. The error can be 

avoided by disabling DEP settings on the IBM Content Collector Server. 

To disable DEP setting, 

a. Go to Control Panel > System > Advanced system settings > Advanced Tab > Performance Section - 

Settings > Data Execution Prevention Tab. 

b. Select Turn on DEP for essential Windows programs and services only. 

c. Restart the IBM Content Collector Server. 

http://www.ibm.com/support/docview.wss?uid=swg27042658
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FileNet P8 CPE 5.5.2 Support 

1. The IBM Content Collector fix pack installation may run into prerequisite missing error if the FileNet CE Client 

and the FileNet Client API are upgraded from older 32-bit versions to the FileNet CE Client and the FileNet 

Client API v5.5.2 which comes only in 64-bit versions. 

In case of this upgrade, install locations are not updated correctly in registry and hence the IBM Content 

Collector cannot identify the appropriate prerequisite installation. This may further lead to IBM Content 

Collector Web Application issues. 

To address this issue, it is recommended to install fresh 64-bit 5.5.2 prerequisites on the IBM Content Collector 

Server instead of upgrading the prerequisites from the older 32-bit version. 

 

Other known problems, restrictions, and solutions that affect administration and usage of fix packs are documented as 

technotes in the product support knowledge database. 

To review all the known problems, restrictions, and solutions that affect Version 4.0.1 fix packs, use the following link to 

query the product support knowledge database: 

http://www.ibm.com/support/search.wss?tc=SSAE9L&atrn1=SWVersion&atrv1=4.0.1&rankprofile=8&dc=DA400&dtm  

 

Installation information 

Apply IBM Content Collector V4.0.1 Fix Pack 10 to update IBM Content Collector V4.0.1 or V4.0.1.1 or V4.0.1.2  or 

V4.0.1.3 or V4.0.1.4 or V4.0.1.5 or V4.0.1.6 or V4.0.1.7 or V4.0.1.8 or V4.0.1.9. 

 

Prior to installation 

Before you install the fix pack in a production environment, make sure that you have a complete backup or 

snapshot of your system so that you can roll back the fix pack installation should a problem arise. If you have 

modified any of the configuration files, take a backup of the modified files including any configuration changes 

in the AFUWeb directory such as afumessage.properties and custom_label.properties before installing the fix 

pack. 

Installing 

To update IBM Content Collector V4.0.1 or V4.0.1.1 or V4.0.1.2 or V4.0.1.3 or V4.0.1.4 or V4.0.1.5 or V4.0.1.6 

or V4.0.1.7 or V4.0.1.8 or V4.0.1.9 with IBM Content Collector V4.0.1 Fix Pack 10, complete the following 

steps: 

For IBM Content Collector Server 

1. Back up your configuration store. 

2. During the uninstallation of web application, eWAS keystores are backed up in the directory, 

ICC_Install_Dir\ AFUWeb_cert_backup. If the directory is not created, back up all the .p12 files present 

in 

ICC_Install_Dir\AFUWeb\ewas\profiles\AFUWeb\config\cells\<CELL_NAME>\nodes\<NODE_NAM

E> 

3. Make sure all the IBM Content Collector services are stopped. 

4. Install IBM Content Collector Server V4.0.1 Fix Pack 10. 

Important: Do not change the host name of the IBM Content Collector Web Application 

during installation. Changing the host name will make all previously created stub links 

unusable. Do not run the Initial Configuration Wizard. 

5. If Lotus® Domino® is one of your source systems and your Domino template contains IBM Content  

http://www.ibm.com/support/search.wss?tc=SSAE9L&atrn1=SWVersion&atrv1=4.0.1&rankprofile=8&dc=DA400&dtm
http://www.ibm.com/support/search.wss?tc=SSAE9L&atrn1=SWVersion&atrv1=4.0.1&rankprofile=8&dc=DA400&dtm
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Collector functionality, re-enable the existing template. From the Windows start menu, select All 

Programs > IBM Content Collector > Set-up Tools > Domino Template Enablement. 

6. If you run the IBM Content Collector in a cluster and use the Cluster Tool afuClusterTool.exe to 

configure the cluster, please run afuClusterTool.exe with the appropriate options to make sure that the 

cluster is configured to fit your environment. For example, ensure the first and secondary configuration 

hosts are set correctly. Refer to SolidDB Setup in an IBM Content Collector cluster to verify if the IBM 

Content Collector cluster is set up successfully. 

7. Restart the Task Routing Engine and the IBM Content Collector Web Application service. 

 

Note: In case of Configuration issues during search, preview or for cluster setup you can perform Configuration 

Web Service from the Configuration Manager > General Settings. 

 For all the other components, install the respective IBM Content Collector V4.0.1 Fix Pack 10 package. 

Notice: During the installation on Windows platform, Windows firewall might pop up blocking program 

warnings. In this case, you should mark them as ‘Trusted’ and add them into the network access trust list. 

Post Installation 

If additional certificates (such as CA certificates) were added to the keystore and / or trust store perform the steps 

below: 

1. Open cmd and run ikeyman 

The IBM Key Management utility opens. 

 

2. In the IBM Key Management utility, select Key Database File > Open 

 

3. Select PKCS12 as key database type. 

4. In the File name field, specify the file name key.p12 

5. In the Location field, specify the backup location . 

6. Click OK. 

7. Select the certificate(s) to be added to Liberty.  

8. Click Extract. 

9. Select default encoding type and specify filename with .cer extension 

10. Click OK 

11. For extracting certificates from trust store repeat steps 2 – 10 by specifying file name as trust.p12 in step 

4 

12. To add extracted certificates to Liberty Keystore, , select Key Database File > Open 

13. Select PKCS12 as key database type. 

14. In the File name field, specify the file name key.p12 

15. In the Location field, specify ICCinstallDir\AFUWeb\wlp\usr\servers\AfuWeb\resources\security 

16. Extracted certificates can be added in “Personal Certificates”by  doing following: 

a. Select “Personal Certificates” 

b. Click Receive 

c. Specify the certificate file 

d. Click OK 

17. Extracted certificates can be added in “Signer Certificates” by doing following: 

a. Select “Personal Certificates” 

b. Click Add 

c. Specify the certificate file 

d. Click OK 

18. Close IBM Key Management utility. 

Note: In Liberty, a single keystore is used as default keystore and trust store. 

http://www-01.ibm.com/support/docview.wss?uid=swg21882791
http://www-01.ibm.com/support/docview.wss?uid=swg21882791
http://www-01.ibm.com/support/docview.wss?uid=swg21882791
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Fixes and changes made in version 4.0.1.10 

New Features 

1. CM 8.6 Connector Support for IBM Content Collector 

The IBM Content Collector Server now supports the use of CM 8.6 connector to connect with CM 8.6 Server and also 

continues to be compatible with the older cm8.5 version. 

2. IBM WebSphere Liberty Application Server Migration 

Starting with IBM Content Collector 4.0.1 Fix Pack 10, the IBM Content Collector Web Application Server has been 

migrated from IBM eWAS (Embedded WebSphere Application Server) to IBM WebSphere Liberty Application 

Server. The version used in this release is 19.0.0.3. 

With this migration, the IBM Content Collector now has the modifications in the deployment Scripts and IBM 

Content Collector Web Application components like AfuWeb, Configuration, Services, API, Docviewer, Report 

Viewer to support WebSphere Liberty Runtime. Migration to WebSphere Liberty does not have many functional 

differences compared to the traditional eWAS other than the ones listed under Known issues / Limitations section of 

this document. 

 

3. JAVA Upgrade 

Starting with IBM Content Collector 4.0.1 Fix Pack 10, the IBM Content Collector Server has been upgraded to 

use IBM Java 8. The current IBM Java version used is 8.0.5.10 as earlier IBM Content Collector versions 

continue to use IBM Java 6. 

 

4. Microsoft Windows Server 2019 Support 

Starting with this release, the IBM Content Collector now supports and has been qualified with Microsoft 

Windows Server 2019 for the following components: 

• IBM Content Collector Server 

• IBM Content Collector SharePoint Extension 

• IBM Content Collector P8 CSS Support 

• IBM Content Collector CM8 Text Search Support 

• Microsoft Windows Server 2019 as a File System Collection Source 

 

Notes: 

• The qualification is done using Windows Server 2019 Data Center edition and the functionality 

shall remain the same with Windows Server 2019 Standard edition. 

• The Microsoft Windows Server 2019 Essential edition and Server core installations are not 

supported. 

• The IBM Content Collector for IBM Domino requires IBM Domino Server 9.0.1 FP10 (32-bit) as a 

prerequisite on the IBM Content Collector Server. 

• The IBM Content Collector for OWA is not qualified on Windows Server 2019 as Windows Server 

2019 requires OWA 2019 only / no prior versions. And OWA 2019 is yet to be supported by IBM 

Content Collector. 

 

5. Support of IBM Domino 9.0.1 FP10 

The IBM Content Collector now enables users to mark documents for archiving or stubbing, to search, view, or 

restore archived content using IBM Domino 9.0.1 FP10. 
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Fixed APARs 

 
APAR HE12703 is fixed in this release. For details, refer to the IBM Content Collector V4.0.1 Fix Pack 10 download 

page at: 

http://www.ibm.com/support/docview.wss?uid=ibm10883002 

 

Documentation 
The following support documentation is available on IBM WebSphere Liberty Application Server Migration:  

http://www.ibm.com/support/docview.wss?uid=ibm10883054 

Online documentation and updates to the documentation 

The IBM Content Collector product documentation is available on the web at: 

http://www.ibm.com/support/knowledgecenter/SSAE9L_4.0.1/contentcollector_4.0.1.htm 

For product information that is missing or is incorrect in the IBM Content Collector documentation, see the technote 

about corrections and updates to the documentation for IBM Content Collector V4.0.1: 

http://www.ibm.com/support/docview.wss?uid=swg27043841 

 

PDF documentation   

The PDF documentation is at the level of IBM Content Collector V4.0.1.   

See the IBM Content Collector publication library for links to PDF documentation in English and other languages: 

http://www.ibm.com/support/docview.wss?uid=swg27042659 

 

 

Notices 

This information was developed for products and services offered in the U.S.A. IBM may not offer the products, services, 

or features discussed in this document in other countries. Consult your local IBM representative for information on the 

products and services currently available in your area. Any reference to an IBM product, program, or service is not 

intended to state or imply that only that IBM product, program, or service may be used. Any functionally equivalent 

product, program, or service that does not infringe any IBM intellectual property right may be used instead. However, it is 

the user's responsibility to evaluate and verify the operation of any non-IBM product, program, or service. 

 

IBM may have patents or pending patent applications covering subject matter described in this document. The furnishing 

of this document does not give you any license to these patents. You can send license inquiries, in writing, to: 

IBM Director of Licensing 

IBM Corporation 

North Castle Drive 

Armonk, NY 10504-1785 

U.S.A. 

 

For license inquiries regarding double-byte (DBCS) information, contact the IBM Intellectual Property Department in 

your country or send inquiries, in writing, to: 

Legal and Intellectual Property Law 

IBM Japan Ltd. 

http://www.ibm.com/support/docview.wss?uid=ibm10883002
http://www.ibm.com/support/docview.wss?uid=ibm10883054
http://www.ibm.com/support/knowledgecenter/SSAE9L_4.0.1/contentcollector_4.0.1.htm
http://www.ibm.com/support/knowledgecenter/SSAE9L_4.0.1/contentcollector_4.0.1.htm
http://www.ibm.com/support/docview.wss?uid=swg27043841
http://www.ibm.com/support/docview.wss?uid=swg27042659
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1623-14, Shimotsuruma, Yamato-shi 

Kanagawa 242-8502 Japan  

 

The following paragraph does not apply to the United Kingdom or any other country where such provisions are 

inconsistent with local law: 

INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS PUBLICATION "AS IS" WITHOUT 

WARRANTY OF ANY KIND, EITHER EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE 

IMPLIED WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS FOR A PARTICULAR 

PURPOSE. Some states do not allow disclaimer of express or implied warranties in certain transactions, therefore, this 

statement may not apply to you. 

 

This information could include technical inaccuracies or typographical errors. Changes are periodically made to the 

information herein; these changes will be incorporated in new editions of the publication. IBM may make improvements 

and/or changes in the product(s) and/or the program(s) described in this publication at any time without notice. 

 

Licensees of this program who wish to have information about it for the purpose of enabling: (i) the exchange of 

information between independently created programs and other programs (including this one) and (ii) the mutual use of 

the information which has been exchanged, should contact: 

IBM Deutschland GmbH 

Department M358 

IBM-Allee 1 

71139 Ehningen 

Germany 

 

Such information may be available, subject to appropriate terms and conditions, including in some cases, payment of a 

fee. 

 

The licensed program described in this information and all licensed material available for it are provided by IBM under 

terms of the IBM Customer Agreement or any equivalent agreement between us. 

 

Any performance data contained herein was determined in a controlled environment. Therefore, the results obtained in 

other operating environments may vary significantly. Some measurements may have been made on development-level 

systems and there is no guarantee that these measurements will be the same on generally available systems. Furthermore, 

some measurement may have been estimated through extrapolation. Actual results may vary. Users of this document 

should verify the applicable data for their specific environment. 

 

Information concerning non-IBM products was obtained from the suppliers of those products, their published 

announcements or other publicly available sources. IBM has not tested those products and cannot confirm the accuracy of 

performance, compatibility or any other claims related to non-IBM products. Questions on the capabilities of non-IBM 

products should be addressed to the suppliers of those products. 

 

All statements regarding IBM's future direction or intent are subject to change or withdrawal without notice and represent 

goals and objectives only. 

 

All IBM prices shown are IBM's suggested retail prices, are current and 

are subject to change without notice. Dealer prices may vary. 

 

This information is for planning purposes only. The information herein is subject to change before the products described 

become available. 
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This information contains examples of data and reports used in daily business operations. To illustrate them as completely 

as possible, the examples include the names of individuals, companies, brands, and products. All of these names are 

fictitious and any similarity to the names and addresses used by an actual business enterprise is entirely coincidental. 

 

COPYRIGHT LICENSE: 

 

This information contains sample application programs in source language, which illustrates programming techniques on 

various operating platforms. You may copy, modify, and distribute these sample programs in any form without payment 

to IBM, for the purposes of developing, using, marketing or distributing application programs conforming to the 

application programming interface for the operating platform for which the sample programs are written. These examples 

have not been thoroughly tested under all conditions. IBM, therefore, cannot guarantee or imply reliability, serviceability, 

or function of these programs. 

 

If you are viewing this information softcopy, the photographs and color illustrations may not appear. 

 

A.1 Trademarks 

 

IBM, the IBM logo, and ibm.com are trademarks of International Business Machines Corporation, registered in many 

jurisdictions worldwide. A current list of IBM trademarks is available on the web at "Copyright and trademark 

information" at http://www.ibm.com/legal/copytrade.shtml. 

 

Java and all Java-based trademarks and logos are trademarks or registered trademarks of Oracle and/or its affiliates.  

 

Microsoft, Windows, Windows NT, and the Windows logo are trademarks of Microsoft Corporation in the United States, 

other countries, or both. 

 

UNIX is a registered trademark of The Open Group in the United States and other countries. 

 

The Oracle Outside In Technology included herein is subject to a restricted use license and can only be used in 

conjunction with this application. 

 

Other product and service names might be trademarks of IBM or other companies.  

 

Document change history  

Date  Description of change  

30 April 2019 Original version published 

 

http://www.ibm.com/legal/copytrade.shtml
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